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Your client needs to reclaim space on their server. To reclaim the space, they want to
purge the deleted documents found in the library. Your client expressed concern that some
of the documents may still be referenced by other documents in the library. These
documents may need to be recovered in the future.
 
 
Which action do you need to take to purge only the documents that are no longer being
used?
 
 
A. Open the Related Documents pane from the View menu. Scroll through the documents
in the Deleted documents view, purging only those with no links in, as displayed in the
lower panel. 
B. Open the Related Documents pane from the View menu. Scroll through the documents
in the Deleted documents view, purging only those with no links to, as displayed in the
upper panel. 
C. Open the Brokenlinks panefrom the View Menu. Scroll through the documents in the
Deleted documents view, purging only those with no broken links in. 
D. Open the Lost Document view. Because this shows only the document with no links in,
you can purge all deleted files from view. 
E. Select all files in the deleted Document view and purge them, because those documents
that are linked to by nondeleted documents will be purged. 
 

Answer: A

Explanation: If you attempt to delete a document from the Library that is used by other

documents, 

you have the choice to delete the selection only or the selection and all related documents. 

Clicking the View related documents link displays a list of the related documents. The 

related documents list includes the direct and indirect links for each parent document 

selected. 

 

The Deleted Documents view in the Library displays the 

documents that have been deleted, but not yet purged by the content Administrator. 

 

 

 

UPK supported languages are grouped by the Tier Structure, Tier 1 and Tier 2. Which of
the following is not translated if it is a Tier 2 language?
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A. Player Interface 
B. Developer 
C. Default and Microsoft template Text 
D. Static text in Document publishing formats 
 

Answer: B

Explanation: As per following table: 

Software User Interface,Tier 1,Tier 2 

Setup Translated Not Translated 

Developer Translated Not Translated 

Player Translated Translated 

 
Reference:ORACLE USER PRODUCTIVITY KIT V11.0 –FREQUENTLY ASKED
QUESTIONS,: What languages are supported by UPK?
 
 

 

 

What is the first step to set up an unattended installation of the Knowledge Center?
 
 
A. Run the executable silently. 
B. Record the parameter file by using the /r parameter. 
C. Log a support ticket. 
D. Use a third-party program to record the installation options. 
 

Answer: B

Explanation: Unattended Installation 

You can use Push technology to distribute executable files for the setup to user desktops.

You 

record response files which contain the pre-determined default settings, and then you can

run 

the executable silently. If you deploy executable files in this manner, no interaction is 

necessary on the part of the user. The administrator can control the installation. 

You can record response files for any of the setup executables. 

Record the Parameter File 

To create a parameter file, you use the /r parameter to run the setup executable in record 

mode. This generates a response file (.iss) that contains the settings you chose while 

recording. These become the default settings 

 
Reference: Oracle User Productivity Kit, Installation And Administration Release 11.0,
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Unattended Installation
 
 

 

 

While you are working offline, the training administrator changes the permissions to the
folder in which you have created a new topic. The permissions are changed to "List Only."
 
 
What happens when you go online and your library is synchronized with the server?
 
 
A. The content administrator is warned automatically and will restore your folder
permissions so that your work is safe. 
B. The document will appear in the Lost document view. 
C. The permissions for the folder are automatically restored to modify permissions during
the synchronization. 
D. I can revert the permissions myself after I receive a system warning. 
 

Answer: B

Explanation: Lost documents 

Lost documents (new or edited documents) can result if permissions change when an

author is 

working offline. For example, if an author had Modify permissions to a folder and then went 

offline while the administrator changed your permissions to List Folder Contents. Any new

or 

edited document will be identified as a lost document when the author reconnects and

begins 

working online. If this happens, an author can display the Lost documents view and recover 

the documents by moving them to a folder with valid permissions. The status bar of the 

Developer displays a message when lost documents are detected. 

 
Reference: OracleUser Productivity Kit, Installation And Administration Release 11.0,Lost
documents
 
 
 

 

 

Identify three compatible file formats that can be used when updating or customizing your
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logo in UPK.
 
 
A. JPG 
B. PPT 
C. TIF 
D. BMP 
E. EXE 
F. PDF 
G. HTML 
 

Answer: A,C,D

Explanation: To customize logos globally for all publishing styles in a category, you can

use the Customize Logo command on the Tools menu. This command prompts you to

choose a category of publishing styles and an image file. You can choose to replace the

default logo with any image in .gif, .bmp, .jpg, .jpeg, .tif, or .png file format. The Developer

converts and renames it to small_logo.gif, and replaces all instances of small_logo and

large_logo in all output styles for the selected category. This process will override any

existing graphics that are in the existing publishing styles. 

 
Reference:UPK Master Documentation Library,Use the Customize Logo Tool
 
 

 

 

During the installation of 110 PRO, you receive an error message. What is the first task you
do when entering “My Oracle Support”?  
 
 
A. Log a Sev 1 Service request. 
B. Look in the Knowledge base for known issues. 
C. Look in patches and updates to see if there is a patch to download to resolve the issue. 
D. Create a forum post asking other clients and support representatives for clues or steps
to be taken to resolve the issue. 
 

Answer: B

Explanation: Search the Knowledge Base for the error. 
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UPK Developer requires Microsoft .NET Framework 3.5. Some of the machines in the
organization where Developer will be installed already have .NET Framework 3.5 installed,
but most do not. Organizational policy dictates that ALL of the machines where Developer
will be installed DO NOT have access to the internet for security reasons. The UPK
installer comes packaged with a "bootstrap" installer for .NET Framework 3.5, which
connects to the Internet to install .NET Framework 3.5 from there.
 
 
Identify the method that would ensure that UPK Developer is installed securely with its
.NET Framework 3.5 requirement.
 
 
A. Temporarily allow all machines access to the Internet during the duration of the
distribution of the installation, so that the "bootstrap" installer can connect properly. 
B. Embed the full .NET Framework 3.5 installer package within the UPK installer, allowing
the UPK installer to use that package Instead of "bootstrap." 
C. Ensure force installation of .NET Framework 3.5 on ALL machines before the installation
of UPK Developer. 
D. Install only to the machines with .NET Framework 3.5 already installed; delay installation
on other machines until they have been updated with .NET Framework 3.5. 
 

Answer: B

Explanation: No need to use the internet to install the.NET Framework 3.5. 

 

 

 

 

A content administrator has asked you to troubleshoot a multi-user UPK Installation: the
authors unable to connect to the server. The administrator sent you the following message
from a Windows event log: 
 
 
The current identity (NT AUTHORITY\NETWORK SERVICE) does not have write access to
"C:\WINDOWS\Microsoft.NET \Framework\v2.0.50727\Temporary ASP.NET Files'.
 
 
Where can you fix this permission problem?
 
 
A. On the Oracle database server 
B. On the affected client workstations 
C. In the UPK library 
D. On the application server 
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Answer: D

Explanation: The .NET FRAMEWORK is used by the application server. 

 

Note: Example: 

When you have created virtual directory of your application created in .Net2.0 and

application is not running.Even everything is fine in web.config, still it is giving error in

web.config file.Error :- The current identity (NT AUTHORITY\NETWORK SERVICE) does

not have write access to 'C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\Temporary

ASP.NET Files'. Solution is goto command prompt then navigate to

directoryC:\WINDOWS\Microsoft.NET\Framework\v2.0.50727Now run this

commandaspnet_regiis -ga "NT AUTHORITY\NETWORK SERVICE"Everything will work

fine. 

 

 

 

Your client has deployed the UPK Developer on a Citrix server, so content authors can
access it remotely in Citrix seamless windows. The target application was also installed on
the same server. The authors are unable to record content.
 
 
Choose three actions that you would take to help discover the problem.
 
 
A. Ensure that the "Time to hide recorder window before screen capture" setting in the
Options dialog box is Increased to at least three seconds. 
B. Ensure that the target application (the web browser for web applications) runs in the
same Citrix session as the Developer. 
C. Ensure that keyboard shortcuts are not recorded automatically. 
D. Ensure that the screen shot capture key is changed from the default. 
E. Ensure that the sound is correctly set up in Citrix. 
 

Answer: B,D,E

Explanation: Remote and Virtual Environments 

The Developer can operate in remote and virtual environments such as Citrix and VMware.

The 

following are known issues when operating the Developer in these environments:  

 

Citrix:  

*(B)When recording a target application running in a Citrix session, then Developer must 

be running in the same Citrix session. 
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*(E)Sound output will likely be choppy. 

* (D)Citrix does not pass the [PrintScreen] key to applications running in seamless

windows. 

The Developer uses the [PrintScreen] key as the default key for recording topics. 

Therefore, the Recorder will not properly recognize the [PrintScreen] key in a Citrix 

seamless window. The recording key can be changed in the Options dialog box in the 

Developer. 

 
Reference: OracleUser Productivity Kit, Installation And Administration Release
11.0,Remote and Virtual Environments
 
 
 

 

 

You maintain a single UPK Developer Library that includes content for the entire
organization. You have created an outline that includes all of the content for the current
project. However, some of the content is sensitive and should be visible only to the Human
Resources group.
 
 
Which process enables you to maintain this library of content and deliver it to the
organization without exposing the sensitive content to the entire organization?
 
 
A. Duplicate the outline and remove the Human Resources topics from the duplicate.
Deliver the full outline to the Human Resources group and the duplicate outline to the entire
organization. 
B. Create a new outline and link all of the existing modules with the exception of the
Human Resources module. Deliver the full outline to the Human Resources group and the
smaller outline to the entire organization. 
C. Create a Role named "Sensitive." Add this Role to all of the Human Resources content.
Publish the outline and use Roles to filter the content appropriately based on the user's
role. 
D. Create a State named Human Resources" Add this State to the Human Resources
content. Use "Publish by State" to publish one outline with and one outline without the
Human Resources State. 
 

Answer: A
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A content author requests your help.
 
 
The UPK Developer does not correctly recognize objects and action areas while recording
a target application.  The author provides you with a sample topic to review. You notice that
the target application appears in a VMware Player virtual machine window in the
screenshots.  The action areas cover the entire virtual machine window, and the objects in
the target application cannot be recognized.
 
 
How can you fix this problem?
 
 
A. The author should disable automatic recording, because it degrades object recognition
when used with a virtualization software. 
B. The author should maximize the VMware Player window during recording so that the
UPK Developer can recognize the objects in the application. 
C. The UPK Developer should be installed in the virtual machine, and the target application
should be recorded inside the virtual machine. 
D. Exact Match is disabled by default for VMware Player in "Target Application
Configuration" in the Options dialog box. This setting must be enabled. 
 

Answer: C

 

 

You can deploy your UPK content by placing the Player package on a web server and
making it available to your users. You do this by copying the contents of the Player
Package folder in the published content. Then you will need to create a link to two files.
 
 
Identify the two files.
 
 
A. play.exe 
B. index.html 
C. default.htm 
D. tocx.html 
E. kp.html 
 

Answer: A,B

Explanation: Linking to the index.html is how to launch the UPK Player(play.exe)when it's

on a web server (including SharePoint or similar). 

Question No : 11
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Note:What is the underlying architecture of the UPK Player? 

A: The UPK Player is DHTML (Dynamic HTML, which is HTML and JavaScript). The

images are PNG format. 

 

 

 

You are engaged as a UPK administrator and publisher for a customer who is in the
process of upgrading their Oracle EBS application suite to R12.x. The UPK content
development team has finished the first set of topics and asked you to publish the content,
so their SMEs can directly access the topic they are responsible for. The SMEs are busy
and do not have time to download Individual topics.
 
 
Which method should you choose to publish and distribute the content?
 
 
A. Publish the content to the individual topic outputs and host the topics on a web server
providing links to each topic. 
B. Publish the content using the Player/LMS output and distribute the player package folder
to each SME. 
C. Publish the content using the Player/LMS output and host the content on a web server
and provide the SMEs with a link to the play.exe file. 
D. Publish the content using the Player/LMS output and host the content on a web server
and provide content developers a link tokp.html. 
 

Answer: B

Explanation: Deploy an LMS Package 

The LMS package enables the creation of a package that conforms to the AICC and

SCORM 

learning specifications. 

 
Reference: OracleUser Productivity, Content Development,Deploy an LMS Package
 
 
 

 

 

You have defined a number of customizations for the Knowledge Center user interface.
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However, when you test them, the customizations are not displayed. You have verified that
the modified files have all been placed in the proper directories.
 
 
What might be the reason your customizations are not appearing?
 
 
A. The local browser cache on the client system accessing the Knowledge Center must be
cleared for the customizations to appear. 
B. You may be using an unsupported browser. Test your customizations in Internet
Explorer version 8 or 9. 
C. You may not have restarted the Web services on the Knowledge Center server. This will
reload the.lng and .cus files on the web server. 
D. It you logged in to the Knowledge Center before you performed your customization, you
will need to log in as a new user to see the customizations. 
 

Answer: C

Explanation: Restart the web services. This step is required because when the Knowledge

Center 

software loads on the web server all contents of lng and cus files are cached in 

memory. To update this information the services must be restarted. 

 
Reference: Knowledge Center: User And Content Management Release 11.0,Create a
Customization File
 
 
 

 

 

You are asked to attend a presales call to support your field account representative with a
sale of UPK. The account representative has asked you to participate in the meeting
because the client has questions about deploying In-Application Support using the
SmartHelp browser add-in option in UPK. 
 
 
The client wants to know what is required to deploy SmartHelp to their user community.
 
 
Identify the best response.
 
 
A. SmartHelp is deployed from a web server by having the user access setup file in the
playerpackage directory. Users installing SmartHelp must have admin privileges and
configure the browsers for ActiveX controls. 
B. SmartHelp is deployed to the user community by installing the UPK single-user option
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on the end user's desktop and configuring the browser for ActiveX controls. 
C. The SmartHelp browser add-in is deployed using the in-application support configuration
utility to push an ActiveX control to the user population. 
D. SmartHelp needs only a web server to run on and is plug-in free. Therefore, it does not
require Installation to deploy it to the user population. 
 

Answer: C

Explanation: An ActiveX control must be installed on the end-user system to enable the

SmartHelp for Internet Explorer. A key feature of ActiveX controls is their simple “download

and execute” deployment model. 

 

The user who installs, configures, and uninstalls SmartHelp must have administrator rights

to the local computer. Medium or medium-low security is recommended for the published

content. In the Security tab, Local Intranet and Trusted Sites have the recommended

security levels. For SmartHelp to work properly, the following settings should be as follows: 

Download signed ActiveX controls: Enable or Prompt 

 

Run ActiveX controls and plug-ins: Enable 

 

Script ActiveX controls marked safe for scripting: Enable 

 

Note:SmartHelp - This is a toolbar button for browsers that end users may use to access 

context-sensitive in-application support content. 

 

 

 

 

Identify two true statements about the installation of the Knowledge Center User Import
Utility.
 
 
A. The Knowledge Center User Import Utility can be installed only before the Knowledge
Center Is installed. 
B. The Knowledge Center User Import Utility can be installed on the same server as the
Knowledge Center. 
C. The Knowledge Center User Import Utility can be installed on any workstation that can
connect to the Knowledge Center. 
D. The Knowledge Center User Import Utility can be installed only in the Knowledge Center
application root directory. 
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Answer: B,C

Explanation: Install the Knowledge Center User Import Utility 

B:The User Import Utility enables you to easily import user names and password

information 

from a file or database into the Knowledge Center. It is a separate program that resides

locally 

and connects to the server. 

There are two things your administrator should supply to you before you install the

Knowledge 

Center User Import Utility on your local workstation: 

*The name of the web server and virtual directory where Knowledge Center is located. 

Please note that the Knowledge Center must be installed before you can use the User 

Import Utility. 

 

*Your user credentials - either your Windows login account, or a user name and 

password that your administrator has created. 

 

C:Choose Destination Location: You can accept the default target location, or click 

Change to specify a different one. 

 

Note:Although the User Import Utility is used with the Knowledge Center, it is not installed

as part of the Knowledge Center. To install the User Import Utility, you must select the User

Import Utility during the installation process. This will create a Knowledge Center User

Import program group. You can launch the User Import Utility with the User Import icon in

the program group. 

 
Reference: OracleUser Productivity Kit, Installation And Administration Release 11.0,Install
the Knowledge Center User Import Utility
 
 
 

 

 

A UPK content author has a single-user installation of UPK 3.6.1 on his or her computer.  
The author would like to keep this installation on his or her machine, but also wants to
Install the single user of UPK 11.0.
 
 
Identify the process that enables this.
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A. The content author needs to create an .odarc file of all the content he or she wants to
keep from the 3.6.1 single-user Installation, and then uninstall 3.6.1. After 3.6.1 is
uninstalled, the author can install 11.0. Two different versions of UPK single user cannot be
installed on one computer at the same time. 
B. The content author can run the UPK 11.0 setup and install UPK 11.0 in a folder structure
that is different from where the UPK 3.6.1 is installed. Both versions of the developer can
be launched independently. 
C. The content author can run the UPK 11.0 setup and Install UPK 11.0 in the same folder
structure as the 3.6.1 Installation. This will upgrade the 3.6.1 installation to version 11.0.
Two different versions of UPK single user cannot be installed on one computer at the same
time. 
D. The content author can run the UPK 11.0 setup and install UPK 11.0 in the same folder
structure as the 3.6.1 installation. Because the cache locations of 11.0 and 3.6.1 are
different, the two versions of the UPK can be launched independently. 
 

Answer: B

Explanation: Q: Can I install UPK 11.0 on top of a previous version?  

A: No. UPK 11.0 cannot install to a location that already includes a previous version (“on

top”). Both the client and 

server installs need to be installed to a new location.  

Q: Can UPK 11.0 be installed on a machine which already has a previous version

installed?  

A: Yes. 

 
Reference: UPK Master Documentation Library, Oracle User Productivity Kit V11.0,
Faq,Upgrading to 11.0
 
 
 

 

 

Which of the following is required to enable end-user access of UPK-generated content-
sensitive help in an application using the UPK Help Integration method? 
 
 
A. The application administrator must manually map context IDs from each page to the
appropriate URLs for help. 
B. The application administrator must make minor configuration changes to the application. 
C. The application developer must write custom code to enable the help system to launch
nonapplication help files. 
D. The application administrator must use the UPK Developer’s Context Editor to map the
application context. 
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Answer: B

Explanation: If help integration is available for a target application, there is usually some

configuration 

that must be done on the application server. 

For an example see note 2 below. 

 

 

Note: 

Implement Help Integration 

*Obtain content - This is a Player package that an author created and published 

from the Developer. 

*Configure content - Use the IAS Configuration Utility to set options for help 

integration. See Application-Specific Configuration Settings. 

*Deploy content - Place the content on a Web server. 

*Integrate Help into the target application - Adjust settings in the target application 

to launch the content. See the appropriate section for your application in Integrate 

Help for Target Applications 

 

Note 2:Agile PLM 

Agile PLM can be configured to launch context-sensitive help through the Help button. 

When the user clicks the Help button, the Player help launches directly or a gateway page 

appears allowing the user to choose between the Player help and the Agile PLM help. 

You configure the Agile PLM application to launch the context-sensitive Player help directly 

from the Help button by using the Java client interface for administration. 

To configure Agile PLM: 

1. Log in to the Agile Java client application. 

2. Click the Admin tab. 

3. Expand the Server Settings item in the tree. 

4. Double-click the Locations item in the tree. 

5. Click the Online Help Manuals URL field. 

6. Enter the server and virtual directory where the published Player content is 

located, for example: 

http://<server_name>/<folder_name>/agile/hemi/agile_gateway.html".  

7. Click the Close button. 

8. Click the Yes button. 
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Identify three statements that are true about the Installation of service pack updates.
 
 
A. You can install these updates without having to reinstall the Developer. 
B. If both UPK and Knowledge Center need to be updated, you must run the installer twice. 
C. As part of the service pack, you must reinstall the UPK Developer. 
D. After installing a service pack for the Developer, you should update each Developer
Library with the appropriate service pack documents. 
E. Service packs will run automatically and you do not need to worry about updating your
toolset. 
 

Answer: A,B,D

Explanation: A:You can install a service pack without having to re-install the Developer

client, single-user, or server software, or the Knowledge Center. 

B:If you receive a service pack update, it may contain updates for both the Developer and

Knowledge Center. If both need to be updated, you must run the installer twice. 

D:After installing a service pack for the Developer, you should update each Developer

Library with the appropriate service pack documents. 

 
Reference: OracleUser Productivity Kit, Installation And Administration Release
11.0,Service Pack Installation
 
 

 

 

What are the minimum permissions needed to run the install scripts?
 
 
A. DB_Accessadmin, DB_Owner 
B. DataReader, DataWriter, DB_Owner 
C. DataReader, DataWriter 
D. DB_Accessadmin 
E. DB_Owner 
 

Answer: D

Explanation:  

 

Note 1:Install the Developer Database Manually 

You can install the Developer database manually by running the scripts provided with the

software. If you are using an Oracle Database, a script creates the schema, populates it

with the appropriate objects, and creates an application user for the schema. If you are

using a Microsoft SQL Server, one script creates the database and the database user, and
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a second script populates the database with the appropriate objects. 

You must have the proper administrative credentials for the database server to create and

populate the tablespace or database. 

 

Note 2:To install the database manually on an Oracle Database server: 

1. From the Windows Start menu, open a Command Prompt window. 

2. To create the tablespace using the CreateSchemaObjects.sql script located in \db

scripts\ORACLE\Developer in the software installation files, enter the following at the

command prompt: sqlplus - SQL*Plus is the command line application for Oracle Database.

-s - Run SQL*Plus without SQL*Plus messaging. <adminuser> - The administrative user

for the instance of the Oracle server. <adminpwd>@<instance> - The password for the

administrative user and the name of the instance. 

 

 

 

When updating a Multi user instance of the Developer with a service pack, what is the one
additional step you need to remember that is not part of the single user update?
 
 
A. Choose the installation location of the service pack. 
B. Update each Developer Library with the appropriate service pack documents. 
C. Choose the application to which you want to apply the update. 
D. Choose the UPK Developer. 
 

Answer: B

Explanation: If you updated Developer, start the Developer and update your Library with

the service pack documents (multi-user environment only). 

 
Reference: Oracle User Productivity Kit, Installation And Administration Release 11.0,
Service Pack Installation
 
 

 

 

Which statement best describes the main purpose of the library functionality within UPK?
 
 
A. It provides a central storage point for all documents. 
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B. It enables you to check out multiple documents at once. 
C. It provides a single location to create content. 
D. It enables you to create multiple documents with the same name. 
 

Answer: C

Explanation: The Developer is the primary content authoring tool that allows you to create

and publish content easily. Using a content Library for organization and storage, you can

build outlines comprised of various documents such as modules/sections, topics,

glossaries, questions, and assessments. 

 
Reference: Oracle User Productivity Kit, Installation And Administration Release 11.0,
Overview and Documentation
 
 

 

 

Identify the statement that is true about the use of UPK client software databases.
 
 
A. The client uses only a server-side database. 
B. The client uses only a client-side database. 
C. The client uses both local-side and server-side databases. 
D. The client does not use any database. 
 

Answer: C

Explanation: The client computer requires an installation of the Developer. The client also

contains a client database (also referred to as the document cache) that is used and

managed by the client desktop software. 

The client database is stored in the Documents and Settings folder by default on the local

workstation, but you can change the location if desired. 

 
Reference: Knowledge Center: User And Content Management Release 11.0, The Client
Database
 
 
 

 

 

The administrator deletes a folder and all of its contents. While working offline, an author
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new topic in the folder that the administrator just deleted.
 
 
What happens when the author checks in the topic?
 
 
A. The topic is deleted because there is no place to store it. 
B. The folder is re-created with the new topic in it. 
C. The author is prompted to create a new folder to store the topic. 
D. The author is prevented from checking in the topic. 
 

Answer: C

 

 

Your library database is corrupted and you decide to restore the database from a recent
backup. However, after the library is restored, one of your users informs you that the user
is not able to check a document that he or she has been editing. When the user does, he or
she gets an error message saying that the document is not checked out, even though
Developer shows it as checked out.
 
 
Identify three statements that are true about this scenario.
 
 
A. The document cannot be checked in because it is no longer in the library. 
B. The user can archive the document by exporting it to an .odarc file and reimport it after
restarting Developer. 
C. You need to run updateRestoreDate.sql on the database. 
D. Before backing up the database, you should have checked the "All checked out" view
and asked all users to check in their documents. 
E. The document did not exist when the backup was made and, therefore, is lost. 
 

Answer: B,C,D

Explanation: B: Note: 

the export process writes all of the selected content to a single compressed 

archive file with the extension odarc. The import process then takes a single odarc 

file as input to re-create the contents of the archive in the current Library. 

C:If a database administrator restores the server database from a backup, the

UpdateRestoreDate.sql script must be run to update specific fields. 

D: 

Note:All checked out - This view lists all checked out documents in the Library sorted 

by the author that has documents checked out (Checked Out By) and document 

Name. Documents appear in a flat view (no folder structure) and display Checked 
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Out By, State, Last Modified Date, Version, and document Type columns. This view 

is useful for administrators who want to determine if there are any checked out 

documents in the Library before they perform software upgrades or other 

maintenance activity.  

 
Reference: OracleUser Productivity, Content Development
 
 

 

 

You manage o UPK Developer Library, which consists of multiple Groups. Each Author
belongs to one or more Groups. You have recently discovered that a user has Modify
permission to the System folder, when the user should only have Read permission.
 
 
What is the best way to prevent this user from modifying the contents of the System folder?
 
 
A. Override checkout on all documents in the System folder, which are currently checked
out to any users, and then check out the System folder so that no changes can be made. 
B. Use the Effective permissions to identify which group or explicit permission provides the
user with Modify permissions to the System folder. Remove the user from that group or
change that group's permission to Read. 
C. Prevent the user from modifying the contents of the System folder by adding them to a
new group which has only the Read permission to the System folder. 
D. Copy the contents of the System folder to a new location In the Library. Export the
System folder copy to an ODARC drive to ensure that the user cannot modify its contents. 
 

Answer: B

Explanation: Assigned and Effective permissions 

Permissions can either be explicitly assigned to an author or in effect due to folder

inheritance or group membership. Explicitly assigned author permissions take precedence

over group permissions when assigned to the same folder. You can view Assigned and

Effective permissions using the Folder Permissions command. 

 

 

 

You are the project lead working with your IT team to set up a multi-user Installation of UPK
in a Citrix environment, identify three correct considerations for this type of deployment.
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A. The server software and the database must reside on the same server and the client
workstations are on the same network. 
B. The server may be accessed through the Internet with communication between the
client and the server through Web Services using HTTP. 
C. The Developer server can support multiple libraries on the same physical server with
users having multiple profiles, one for each library. 
D. The Developer can operate in remote and virtual environments such as Citrix and
VMware without any special considerations. 
E. When recording a target application that is running a Citrix session, the Developer
server must be running in the same Citrix session. 
F. The Recorder will not properly recognize the PrintStreen key in Citrix, so the recording
key must be changed to F8 in the Developer server. 
 

Answer: B,E,F

Explanation: B:It is also possible to access the server through the Internet. All

communication between 

the client desktop and the server is through Web Services using HTTP.  

E:When recording a target application running in a Citrix session, then Developer 

must be running in the same Citrix session. 

F:Citrix does not pass the [PrintScreen] key to applications running in seamless 

windows. The Developer uses the [PrintScreen] as the default key for recording 

topics. Therefore, the Recorder will not properly recognize the [PrintScreen] key in 

a Citrix seamless window. The recording key can be changed in the Options dialog 

box in the Developer 

 
Reference: OracleUser Productivity Kit, Installation And Administration Release
11.0,Remote and Virtual Environments
 
 

 

 

The customer is not satisfied with the default wording used in some of the links, buttons,
and messages in the Knowledge Center user Interface and would like to change them.
 
 
How is the value for the stringid variable determined when defining the custom text in the
eu<langid>.cus file?
 
 
A. Identify the last or highest stringid already in use in the eu<langid>.lng file and begin
numbering your custom strings with the next integer. 
B. Use the same stringid value defined in the eu<langid>.lng file for the string you will be
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customizing in the eu<langid>.cus file. 
C. The stringid value is a hexadecimal representation of your custom text. Use a “text to
hex” conversion toll to identify the hexadecimal value to use as stringid for your custom
text. 
D. Your custom strings should have stringid values beginning with 1 and use incremental
integer values for each subsequent custom string. 
 

Answer: B

Explanation: To specify custom text blocks or graphics, you must create a “customization”

file that contains 

your custom information. This is accomplished by creating a new file named

eu<langid>.cus. 

This file uses the same file structure as the eu<langid>.lng file. You only need to add the 

specific text blocks and graphics that you are modifying to the “customization” file, because

the 

eu<langid>.lng is read first and then the eu<langid>.cus file is read to pick up any 

customizations. 

 

Customize Text 

Every text block in the user interface can be customized. This allows you to customize the 

messages that appear to the user on pages, error dialogs, and so on.  

The first step in changing the text is to identify the block of text that you wish to customize 

and determine its stringid. There are two different methods for doing this. One method is to 

copy the text from the Knowledge Center user interface and search the eu<langid>.lng file

for 

the appropriate item. You can then place the appropriate entry in your customization file 

(.cus). Knowledge Center also provides a special mode that allows you to view the stringids

as 

you are running the user interface. 

 
Reference: OracleUser Productivity KitKnowledge Center: User And Content
Management,Basic Customization
 
 
 

 

 

Your customer has a custom built application for which the customer has created a robust
text-based Help system. The customer has contacted you for your expert knowledge in
deploying UPK player content. The customer wants to add links to "See It!" mode and "try
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it!" mode simulations in their online documentation, but does not want users to have to
navigate the UPK Player table of contents.
 
 
Identify the option that would support this requirement.
 
 

Answer: The customer should publish each topic using the Individual topic output, host

each on a web server, and link to each file from their documentation. 

Answer: The customer should host the published player package on a web server and use

the kp.html file to derive each link to each topic and mode. 

Answer: The customer should host the published player package, launch index.html, and

navigate to each topic and copy the URL from the address bar of the browser. 

Answer: The customer should deploy the content using the Help Menu integration method

and use ExactMatch context matching to locate each topic's URL. 

Answer: D 

The Help Menu Integration folder contains the files necessary for launching content from 

the Help menu of an application. Each category or "brand" has its own subfolder. Within 

the subfolder, the files necessary for supported target applications are in stored in a 

package document. These files are automatically published with the Player content. The 

Help Menu Integration folders and documents that appear depend on the product category 

that you are using. 

 

 

Your training coordinator has updated the publishing styles to reflect the new company
logo. The styles are in the Styles folder, which is located in the System/Publishing folder.
You have been asked to make the necessary permission changes to prevent other users
from making changes to the styles, while retaining the ability to publish content.
 
 
What do you do to handle this request?
 
 
A. Set the styles folder to list permissions. 
B. Set the system folder to read permissions. 
C. Remove all users from the group that has access to the system folders. 
D. Send out an email to all users requesting not to change the styles. 
 

Answer: B

Explanation: Understand Content Permissions 

By default, all authors have complete access to all Library folders and all actions that you 

can perform to develop, modify, publish, and export content. However, your administrator 
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can also restrict your ability to access content in any Library folder and perform actions on 

that content.An administrator can assign the following permissions: 

The following permissions can be set for any folder in the Library: 

• List Folder Contents - Authors cannot save to folders with this permission. An 

author can view the names of documents in a Library folder but cannot open a 

document in any editor and perform actions that would change the document 

content or its location in the Library. An author also cannot make a copy of the 

document in any way. 

 

Read - An author can open a document in an editor, but cannot perform any 

actions that would change the document content or its location in the Library. An 

author can make a copy (including Save as) of the document and store it in a 

folder location to which they have appropriate permissions. 

 

Modify - An author has complete access to the folder and its documents and can 

perform any action (create, modify, copy, delete, publish, export, and so on). 

 

Note:Publishing styles are Publishing Project documents that are stored in the 

System/Publishing/Styles folder in the Library. Within the Styles folder, each category has 

a folder. Each output format has its own Project document, such as Job Aid and Player. 

 

Note 2:Also note that you must have Modify permission to the folder where the publishing 

styles (or project documents) are stored for the category you select to successfully 

change logos. 

 
Reference: Oracle User Productivity, Content Development,Understand Content
Permissions
 
 
 

 

 

You are tasked with installing the Knowledge Center Database using the scripts that are
stored on the G drive. Your company currently uses SQL Server 2008.
 
 
What are the commands used to build the database using the scripts?
 
 
A. Sqlcmd – I –S“mysqlserver” – i ” G:\Setup\db 
scripts\MSSQL\knowledgwCenter\createDBObjects.sql “ – n DBOwner =” KUser 
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password = “password” – v DBName = “KMASTER” – v DBPath = “C: \ database” 
B. Sqlcmd – E – S“mysqlserver” – i ” G:\Setup\db 
scripts\MSSQL\knowledgwCenter\createDBObjects.sql “ – n DBOwner =” KUser 
password = “password” – v DBName = “KMASTER” – v DBPath = “C: \ database” 
C. Sqlcmd – E – s “mysqlserver” – e ” G:\Setup\db 
scripts\MSSQL\knowledgwCenter\createDBObjects.sql “ – n DBOwner =” KUser 
password = “password” – v DBName = “KMASTER” – v DBPath = “C: \ database” 
D. Sqlplus – s system/password@xe @ “E:\Setup\db 
scripts\ORACLE\KnowledgeCenter\CreatesSchememaObjects.sql.sql” KUser password
KMaster 
“C: \ app \ oradata \ orcl \ KMaster.DBF” KMaster_TEMP 
“C: \app\oradata \ orcl \ KMaster_TMP.DBF” 
 

Answer: B

Explanation: Use Sqlcmd – E – S“mysqlserver” – ietc. 

 

To create the database using the CreateDB.sql script, enter the following at the command

prompt: 

 

sqlcmd - The command line application for the Microsoft Sequel server. 

 

-E - Use a trusted connection to the Microsoft Sequel server. To use a login and password,

use the -U <LOGINID> -P <password> parameters. 

 

-S <servername> - The name of the Microsoft SQL server. 

 

-i "<scriptfile>" - The path to the script file and the name of the script file. 

 

-v DBName="<database name>" - The name of the database to be created. 

 

-v DBPath="<database file location"> - The path to the location where you want to create

the database. 

 

Statement with generic parameters: 

sqlcmd -E -S <servername> -i <scriptfile> -v DBName="<VALUE1>" -v

DBPath="<Value2>" 

 

Example with default install parameters: 

sqlcmd -E -S "mysqlserver" -i "CreateDB.sql" -v DBName="KMASTER" -v

DBPath="C:\database" 
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Select the two UPK printed documentation outputs that incorporate all items of the
published outline.
 
 
A. Business Process Document 
B. Training Guide 
C. Instructor Guide 
D. Presentation 
E. Job–Aid 
 

Answer: B,C

Explanation: Training Guide: A printout of the full content of all Topics for a published

Outline. This is suitable for use as a handout for trainees. 

 

Instructor Manual: A printout of the full content of all Topics for a published Outline,

including brief instructor notes. This is suitable for use as a "teacher's edition" of a Training

Guide, for use by an instructor during classroom training. 

 

 

 

The customer's IT department will not allow anyone outside the department to create a
database on its database servers. Identify two considerations to keep in mind while setting
up the developer server in this kind of environment.
 
 
A. The IT department can download sample databases from Oracle's website that can be
used as the developer database. 
B. The IT department can run a "Database-only" installation or use the scripts provided in
the media pack to create the database on its server manually. 
C. The developer server application must be installed before the database is created on the
database server by the IT department. 
D. The database must be created on the database server by the IT department before the
developer server application is installed. 
E. The developer server application and database must be on the same machine, so the IT
department will have to install the developer server at the time it creates the database. 
 

Answer: B,D
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When installing the multi-user UPK Developer server, you can deploy on either a
nonsecure website or a secure website with secure sockets layer (SSL). Your client asks
you why installing on a secure website is the preferred method. Which four reasons would
you give the client?
 
 
A. encrypts authentication data soit is not transported in clear text across networks 
B. encrypts sensitive data 
C. authenticates that the web server is being accessed by users who are who they say they
are 
D. protects data that should be accessed by certain users, and not accessed by others 
E. enables quicker publishing of content for deployment 
F. disables direct publishing to a live Knowledge Center environment 
 

Answer: A,B,C,D

 

 

Identify the mandatory requirement when planning to record an unattended installation.
 
 
A. license file available to all users and accessible on the same path 
B. response file in the same folder from where the installation runs 
C. users have write permission to the folder where setup.exe resides 
D. users have the same mapped network drives that you do 
 

Answer: B

Explanation: Run the Executable Silently 

Once you have recorded a parameter file, you can use the /s parameter to run the setup 

silently. By default, the installation process will look for the response file (.iss) in the same 

directory as the setup.exe. You use the /f1 parameter to specify a different location of the 

iss file.  

 

 

Note: 

Unattended Installation 

You can use Push technology to distribute executable files for the setup to user desktops. 
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You record response files which contain the pre-determined default settings, and then you 

can run the executable silently. If you deploy executable files in this manner, no interaction 

is necessary on the part of the user. The administrator can control the installation. 

You can record response files for any of the setup executables. 

 

Record the Parameter File 

To create a parameter file, you use the /r parameter to run the setup executable in record 

mode. This generates a response file (.iss) that contains the settings you chose while 

recording. These become the default settings. 

The setup.iss file is stored automatically in the Windows folder. You can use the /f1 option 

to specify a different location in which to create the response file. 

 
Reference: Oracle User Productivity Kit, Installation And Administration Release 11.0, Run
the Executable Silently
 
 

 

 

Although you can manually customize the logo in each publishing style, such as the player,
the Presentation, and the document formats, you can also globally change the logo in all
publishing styles and languages for a specific category in the library.
 
 
Which menu in the KPK Developer do you use to complete this task?
 
 
A. File 
B. Edit 
C. Administration 
D. Tools 
 

Answer: D

Explanation: To globally customize logos for a category of publishing styles: 

1. On the Tools menu, choose Customize Logo. 

2. Select a category or accept the default. 

3. Browse to the location of the image file and select it. 

4. Click OK to process the changes. When the process is complete, you can view the 

activity to determine the changes that were made. 

5. Click OK to close the Update dialog box. 

 
Reference: Oracle User Productivity, Content Development, Use the Customize Logo Tool
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